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TechFacts 98 Overview
TechFacts 98 is a powerful Windows 95/98 tool that empowers you to diagnose, solve and report 
Windows problems.

TechFacts is structured into several functional areas:

· A Resource \ Disk \ CPU \ Memory monitor with several unique views and individual alarms.
· A Spy \ Trace \ Diagnostic tool that explores all aspects of Windows.
· A powerful reporting tool that lets you transmit TechFacts information to other people or organizations.

TechFacts 98 is supplied with the following files:

· tekfct98.exe - The executable file.
· tekfct98.hlp - The help file.
· tekfct98.dll - The dynamic link library.



Contacting Dean Software Design

Address:
Dean Software Design
P.O. Box 13032
Mill Creek, WA 98082-1032

Phone:
Technical: 425-316-8645
Orders: 1-888-282-5887

Email:
America Online: Winutils@aol.com

Website:
www.winutils.com

Secure web ordering:
www.qwerks.com
Compuserve SWREG forum
see our web page for additional options



Starting TechFacts 98

TechFacts 98 can be opened in several different ways:

· From an icon or shortcut to the executable.
· By another program.
· From the DOS command line with line command options.



How to End TechFacts 98
You can close TechFacts 98 in 3 different ways:

· Click on the 'X' in upper right corner of the TechFacts window.
· Click on the 'X' button in the TechFacts toolbar.
· User the "Exit" menu option in the "File" menu.

When you close TechFacts 98 it remember the position and size of the TechFacts window so that it can 
be restored for your next session.



Installing TechFacts 98
TechFacts 98 utilizes Installshield (tm) setup technology. It can be installed into any local or network 
directory.

The first time TechFacts 98 is run on a system it will automatically invoke an embedded "Setup Wizard" 
which walks you through setting up several key pieces of information that TechFacts 98 needs to put in 
the registry.

TechFacts 98 only inserts items on your system in the following places:

· The directory where TechFacts 98 is installed will contain the executable, a DLL, the help file and a web 
link list file.

· The Windows Registry under the "HKEY_CURRENT_USER" key will have a "Dean Software" entry 
under the "Software" key. Within this sub-key will be a TechFacts 98 entry.

TechFacts 98 added no other DLLs, Device drivers, INI files or Help files to your system.



Uninstalling TechFacts 98
From your Start bar invoke the Windows Control Panel.

Select "Add/Remove Programs" from the list of Control Panel options.

From the list of installed applications select "TechFacts 98" and click on the "Remove" button.

You do not need to reboot your system after the Uninstall is complete.



Configuring TechFacts 98

TechFacts 98 can be configured dynamically during use. Changes to configuration take effect 
immediately.

To invoke the Configuration form, click on the Configure speedbutton or select the "Configure" option from 
the "File" menu. Either of these options will cause the configure form to be displayed.    To close this form, 
click on "Save" to save any changes you made, or "Cancel" to close without saving any changes you 
made.

The configuration form provides several tabs which relate to different functional areas of TechFacts. You 
can modify items on any of the tabs as follows:

General Tab

· Monitor refresh interval. This is the number of ms between each refresh of the custom monitors. From 
250ms to 10000ms in intervals of 250.

· Name on Faxes and Email. A descriptive name that will be automatically posted onto faxes & emails 
you send using TechFacts.

· Default identifier. A shorter name\id that will get written to alarm and capture logs.
· General font. The font that will be used on all TechFacts displays is shown. Use the speedbutton to 

select a different font, size or color.

Startup Tab

· Start TechFacts as a:

Monitor Window. This is a normal display mode.
Icon. TechFacts will immediately reside in the system tray.

Alarms Tab

· Audible Alarms. Any resource\performance alarm will cause a speaker sound or a multimedia alarm.
· Display Warning. Indicate that an alarm has triggered with a message to the user.
· Log to file. Make an entry to the TechFacts log file indicating the alarm, date, time and user id.
· Log File Name. Indicate the path and filename for the TechFacts log file. Can be local or network. The 

Browse button can be used to explore local\network drives.

MAPI Tab

· Allow use. This checkbox will enable\disable the use of MAPI email by TechFacts.
· Default Recipient's Email. By entering a MAPI email address here, your system's MAPI email interface 

will automatically address the email.
· Default subject. This field allows a standard subject to be attached to all MAPI emails, ie: Tech Support.

SMTP Tab

· Allow use. This checkbox will enable\disable the use of SMTP email by TechFacts.
· Default Recipient's Email. By entering an internet email address here, TechFacts will automatically 

address the email when sent.
· Default subject. This field allows a standard subject to be attached to all internet emails, ie: Tech 

Support.
· SMTP server. This is the name or address of your internet email SMTP mail server. It may be a proxy or 

you can determine it by examining the Options menu under Netscape Navigator or Microsoft Internet 
Explorer or other browsers.



· Your email. This is your email address on the mail server.
· Encoding. Select UUEncode (default) or Mime encoding for attachments on the email.
· Character set. Select either US Ascii (default) or ISO-8859-1 character sets.

Search Tab

· Clear list. Automatically have Techfacts clear all prior search results before starting any new searches.
· Icon sizing. This determines the spacing between icons in the search results panel. From 38pixels to 

100 pixels.

Security Tab

· Security on TechFacts 98 being closed. Click on this option to have a password required in order to 
close the program.

· Security on Maximizing TechFacts 98. Click on this option to require a password to maximize TechFacts 
98 from an icon.

· Security on modifying options. Click on this option to require a password in order to change the 
TechFacts 98 options.

· Security on modifying system settings. Click on this option to require a password to use the Tweak 
function to change Windows settings.

· Password Entry. Click on this button to use a password entry form to enter or change your TechFacts 
98 password.

Print Tab

· Print Columnar data using column widths. This option will use default widths of the columns on which 
the data appears while printing.

· Print Columnar data using maximum data width. This option will force data to be printed using the width 
of the largest data item in each column.

· Add to column width. This option will force a number of extra bytes of data per column to be printed.
· Print Font. Use this button to change the printer font, size, color and style.



Command Line Options / Preloading Config Options
There are several command line options you can issue with TechFacts 98, they are all optional, however 
you can only issue 1 command line option at a time.

· Quick help on Command:    "TEKFCT98 ?" . This will show a dialog with the options available then exit 
the program.

· Run a Version search: /versearch. Uses version search parameters to run a search for files with version 
info.

· Automatically exit TechFacts 98: /autoexit.

· Pre-load config options: "TEKFCT98 /LoadFile xxxxxx.xxxx" where xxxxxx.xxx is the name of the 
preload file.

The pre-load file is an ascii text file containing INI style representation of the registry values for TechFacts 
98 configuration. The easiest way to create a file is to use the "Save Config to File" option under the "File" 
menu. (see help page on that topic by clicking on Next).

You do not need to have lines in this file for items you do not want set. Each is optional.



Using TechFacts 98 Controls
Controls within this program include buttons, tab sheets and data areas.

· Buttons.    TechFacts incorporates the new Windows 97 style of button found in programs such as 
internet explorer while also utilizing standard buttons and buttons with bitmaps. 

· Tab Sheets. Tab sheets allow you to display many different types of data within a set viewing area. You 
change what you see by clicking on a different tab name.    Changing tabs does not cause data in non-
visible tabs to be erased, it simply pushes it behind the visible tab.

· Data Areas. TechFacts 98 uses RichEdit, ListView and custom data areas. 



TechFacts 98 Monitor Functions

The Monitor tab provides functions that let you monitor disk, resources, memory, performance and 
activities.

When you click on the Monitor tab you will be shown several monitor buttons. To select a monitor click on 
the specific button.

All program resources such as printing, refresh & clipboard are available once data is displayed for a 
monitor.

Custom Monitor
Performance Monitor
Process Monitor
Keyboard Monitor



TechFacts 98 Custom Monitors
Custom Monitors are available to monitor CPU usage, Disk usage, GDI, USER and System Memory.    
There are 4 seperate monitors which can be set as needed.

A custom monitor is divided into 3 sections - The Title, the graph and the text. You can modify the type 
and appearance of a monitor by Right-Clicking your mouse on the title or text portion of each of the 4 
monitors. After a click you will be shown a menu with 4 options:

· What to Monitor - select the system resource to monitor.
· Monitor Type - select either a Horizontal or Vertical bar graph, a Pie chart or a needle graph.
· Alarms Settings - Determine the alarm level to trigger alarms at.
· Reset this Alarm - Once an alarm has triggered use this option to reset the alarm for retrigger.

When TechFacts is resized the monitor will also resize.



TechFacts 98 Performance Monitors

Performance Monitors are available to monitor the performance keys within the Window registry. These 
keys are dynamic and may change from session to session.

The Performance view window is divided into several columns:

· The registry performance key.
· The current value
· The maximum value
· The last time the value was updated

At the bottom of the window are several controls that affect the performance monitor:

· Start the performance monitor
· Stop the performance monitor
· Clear the performance monitor view window of all values.



TechFacts Process Monitor
The Process Monitor is a dynamic way of watching processes start or finish. A process may be a program 
or an application that you start or that Windows invokes.

When the process monitor is started you will see the data form fill with information about processes that 
are already active. Once invoked, all new processes or processes that terminate will cause an additional 
line to be entered into the data form.

There are several controls at the bottom of the Process Monitor window:

· Start the process monitor
· Stop the process monitor
· Clear the process monitor view window of all data.

The data form may be printed, saved to file or copied to clipboard using the menu options or speedbar 
buttons.

Note that you may also have the process monitor invoked automatically during TechFacts 98 startup by 
setting the options on the Configuration form.



TechFacts Spy Functions
The Spy tab provides functions that let you examine Processes, Modules, Threads, Heaps, Windows and 
Atoms.

When you click on the Spy tab you will be shown several buttons. To select a Spy function click on the 
specific button.

All program resources such as printing, refresh & clipboard are available once data is displayed for in the 
Spy Window.

Data in this window is displayed in sortable\sizeable columns. You can sort the data by clicking on any 
column header and you can size any column by dragging on the column separation line.

Spy data can be 'drilled' to a lower level of detail. Double-click on the data in the first column in order to 
invoke the detail form.

Spying on Processes
Spying on Modules
Spying on Threads
Spying on Heaps
Spying on Windows
Spying on Atoms
Process Heap Usage



Spying on Processes
This function provides you with a list of all processes running under Windows 95/98. This is valuable in 
determining whether there are programs or applications or applets that are running outside expected 
parameters.

The following information is displayed:

· Process - The name of the process as registered with Windows.
· Process ID - The 'handle' or identifier Windows uses for this process.
· Module ID - The 'handle' or identifier for the physical module that was loaded for this process.
· Priority - How Windows treats this process: Low, Medium or High.
· Full Name - The full path and file name of the applications's module.
· The information displayed can be sorted by any of the columns shown. To sort, click on the column 

name. Sorting may take several seconds.

You can get additional details of the Process by Double-Clicking on the Process Name for which you want 
more details.

Using the Menu or Speedbar you can: Print, Copy to Clipboard, Clear the List or Save the information to 
File.

You may also send this information via MAPI Email or Internet Email.



Spying on Modules
This function provides you with a list of all DLLs (modules) that a specific process loaded. Since Windows 
95/98 provides an address space for each process, the modules loaded for a specific process will be 
different than other processes (unlike Windows 3.1x which shared all modules between tasks).

This data returned from this lookup is:

· Module Name - The file name of the loaded module. To get the path, use the Detail screen (see below).
· Module ID - The 'handle' or identifier assigned by Windows for this module.
· Global Count - The number of times Windows programs or modules have globally referenced this 

module.
· Process Count - The number of times the parent process of the module has referenced this module.
· Size - The size in bytes of the memory used by this module.

The information displayed can be sorted by any of the columns shown. To sort, click on the column name. 
Sorting may take several seconds.

You can get additional details on a Module by Double-Clicking on the Module Name for which you want 
more details.

Using the Menu or Speedbar you can: Print, Copy to Clipboard, Clear the List or Save the information to 
File.

You may also send this information via MAPI Email or Internet Email.



Spying on Threads
Thread are entities to which the CPU will allocate processing time. Threads process parts or all of 
processes and can transcend several processes.

· Thread ID - The 'handle' or identifier that Windows assigned this thread.
· Owner Process - The 'handle' or identifier of the parent process of this thread.
· Count Usage - The number of references made by the Thread, usually 0 or 1.
· Priority - The CPU priority assigned to the thread. The higher the number the higher the priority.

The information displayed can be sorted by any of the columns shown. To sort, click on the column name. 
Sorting may take several seconds.

You can get additional details on a Thread by Double-Clicking on the Thread Id for which you want more 
details.

Using the Menu or Speedbar you can: Print, Copy to Clipboard, Clear the List or Save the information to 
File.

You may also send this information via MAPI Email or Internet Email.



Spying on Heaps
Each Process, Module or Object within Windows can dynamically or statically grab portions of memory to 
store code, properties or data. This memory is called Heap. Heap is allocated using 'blocks' of memory.

When you select this option you will be shown a form with all the heaps listed. Click on a specific heap in 
order to enumerate all the heap blocks for that heap.

The Heap information gathered on this form is:

· Handle - The identifier assigned by Windows for this heap block.
· Address - The Memory address for this heap block.
· Size - The number of bytes of Heap allocated to this block.
· Type - The type of heap allocation: Fixed, Free or Moveable.

The information displayed can be sorted by any of the columns shown. To sort, click on the column name. 
Sorting may take several seconds.

You can get additional details on a Heap Block by Double-Clicking on the Heap Id for which you want 
more details.

Using the Menu or Speedbar you can: Print, Copy to Clipboard, Clear the List or Save the information to 
File.

You may also send this information via MAPI Email or Internet Email.



Spying on Windows
Windows are the visible or non-visible entities under Windows that displays information to the user. Non-
visible windows may be ones that are hidden or minimized or on forms that are not yet displayed. 
Windows include icons, status bars, menus and desktop entities.

This option returns the following information about Windows:

· Window Class - Class refers to the overall Windows grouping that created and owns this particular 
window. This can refer to an application or a grouping of Windows within an application.

· Window Title - The title assigned to the window. This may be what is seen on a title or it may be a name 
assigned by an application.

· Handle - This is the identifier assigned by Windows used to reference this window.
· Parent - The handle of the parent windows of this window. If the parent is '0000' then the parent is the 

Windows Desktop itself.

The information displayed can be sorted by any of the columns shown. To sort, click on the column name. 
Sorting may take several seconds.

You can get additional details on a Window by Double-Clicking on the Window Class for which you want 
more details.

Using the Menu or Speedbar you can: Print, Copy to Clipboard, Clear the List or Save the information to 
File.

You may also send this information via MAPI Email or Internet Email.



Spying on Atoms
Atoms are handles pointing to strings defined in the system atom table. These strings are available to be 
used by applications.

· Atom # - The id of the atom.
· Size - The size in bytes of the memory allocated to the string.
· String - The string characters available for reference for this atom.

The information displayed can be sorted by any of the columns shown. To sort, click on the column name. 
Sorting may take several seconds.

Using the Menu or Speedbar you can: Print, Copy to Clipboard, Clear the List or Save the information to 
File.

You may also send this information via MAPI Email or Internet Email.



Process Heap Usage
The Process Heap usage function allows you to dynamically see how much heap each of the processes 
on your system is using.

Heap consists of blocks of extended and expanded memory that are allocated or freed statically or 
dynamically by programs and modules.

Invoking this function will cause TechFacts 98 to calculate heap usage, which depending on the number 
and size of your processes, could take up to a minute.

When complete, you will be shown the following data:

· Process Name
· Total Fixed Block size in bytes
· Total Free Block size in bytes
· Total Moveable Block size in bytes
· Total Number of Memory Blocks

You can print, save or copy the information to the clipboard.

Info Usage: You can estimate the memory usage and seek memory leaks by taking Process Heap Usage 
"Snapshots" before and after you run a program.

Compare the usage and look for blocks that are not freed and for memory allocation by unrelated 
processes.



TechFacts System Functions
The System tab provides functions that let you examine CMOS, Version, Multimedia, Registry, 
Performance, CPU, Devices Installed and Device Mapping.

When you click on the System tab you will be shown several buttons. To select a System function click on 
the specific button.

All program resources such as printing, refresh & clipboard are available once data is displayed for in the 
System Window.

Data in this window is displayed in sortable\sizeable columns. You can sort the data by clicking on any 
column header and you can size any column by dragging on the column separation line.

Version Information
Dumping CMOS
Multimedia Devices
Performance Information
Windows 95/98 Registry
Device Mapping
Devices installed on Your System
CPU Information



Version Information
This function provides you with information regarding your system's operating system version.

Using the Menu or Speedbar you can: Print, Copy to Clipboard, Clear the List or Save the information to 
File.

You may also send this information via MAPI Email or Internet Email.



Dumping CMOS
Your system manages settings of hardware, software, dates, times and specific vendor information in a 
hardware area called CMOS.

Using the Menu or Speedbar you can: Print, Copy to Clipboard, Clear the List or Save the information to 
File.

You may also send this information via MAPI Email or Internet Email.



Multimedia Devices
Multimedia devices includes all hardware connected to your system such as CD-ROMs, pointing devices, 
sound devices and accessories. Windows 95/98 manages these devices internally. This option permits 
you to view the list of WIndows managed multimedia devices.

Using the Menu or Speedbar you can: Print, Copy to Clipboard, Clear the List or Save the information to 
File.

You may also send this information via MAPI Email or Internet Email.



Performance Information
Performance data about your system is managed in the Windows Registry. This includes data about your 
CPU, disk utilization, network performance, etc.    Unlike the performance monitor, this option simply takes 
a point-in-time snapshot which you can examine.

Using the Menu or Speedbar you can: Print, Copy to Clipboard, Clear the List or Save the information to 
File.

You may also send this information via MAPI Email or Internet Email.



Windows 95/98 Registry
The Windows 95/98 Registry replaces the swarms of INI files that Windows 3.1x maintained. The registry 
is contained in several high performance disk files which are accessed by WIndows 95/98 and most 
compliant programs.    This option allows you to simply dump the registry (by section) to examine it or 
search for specific information.

Using the Menu or Speedbar you can: Print, Copy to Clipboard, Clear the List or Save the information to 
File.

You may also send this information via MAPI Email or Internet Email.



Device Mapping
When connected to networks or remote devices, Windows 95/98 may redirect your local device mapping 
(ie: A,B, C or COM1) to point to remote or linked devices. This may include CD-ROMs or Zip drives. This 
option dumps the Windows device redirection table.

Using the Menu or Speedbar you can: Print, Copy to Clipboard, Clear the List or Save the information to 
File.

You may also send this information via MAPI Email or Internet Email.



Devices Installed on your System
This function lists the devices and drivers found in your system via their registration in the Windows 95/98 
registry.

All devices such as cards, disks, cd rom, multimedia, game ports, scanners, etc.. must use the Windows 
95/98 registry in order to be "recognized" by the OS and applications.

Since no device or driver has a specific data format we cannot list the data items listed, however the 
following data should be common to most entries:

· Class - The type of device, ie: Disk, Printer..
· Device Desc - Description of the specific device or driver.
· Driver - The Windows internal driver entry.
· Manufacturer - Who made the device.

Info Usage: Use the machine data to seek incompatible devices, old versions of drivers or to provide a list 
of installed devices to your system's technical support department.

You may also send this information via MAPI Email or Internet Email.



TechFacts Action Functions
The Action tab provides you with several different activities which can be used to modify, save or capture 
elements of Windows 95/98.

When you click on the Action tab you will be shown several buttons. To select an action click on the 
specific button.

Program resources such as printing, refresh & clipboard are not available for the action functions.

Terminating Processes
Unloading Modules
Screen Capture
Saving CMOS Settings
Restoring CMOS



Terminating Processes
Though not recommended as a regular activity, you can use TechFacts to terminate processes 
maintained by Windows. This may be useful if a process is hung or if you want to determine how other 
programs may react to a process terminating.

You will be shown a list of all processes. Select the one you wish to terminate and click on "Terminate" 
button.

Note: Due to the inherant security aspects of Windows 95/98, you may be denied access to terminate 
certain processes.



Unloading Modules
You can use TechFacts to attempt to unload Modules owned by a given process. You may want to do this 
in cases where incorrect versions of modules are loaded or when you are testing how processes react to 
a module terminating.

Unloading a module is a 2 step process:

1. You will be given a list of all processes. Select the process for which the module you are seeking was 
loaded.

2. From the list of modules owned by the specific process, select the module to unload and click on the 
"Unload" button. The module list will rebuild and you will notice that the Count has been decremented or 
the module no longer appears.

Note: Windows 95/98 provides limited access to other process's modules. There may be times when 
TechFacts 98 can not unload another process's modules.



Screen Capture
The screen capture utility can be used to capture all or portion of your desktop into standard bitmap 
images. You can then save these images to disk, print them or use the clipboard to paste them into 
documents.

Choose from one of the 3 capture types:

1. Capture Entire Desktop - The whole screen (ie: 800 x 600) is captured.

2. Capture a Specific Window - You will be given a cursor to place over a specific window. Click on the 
window and the contents of the frame and window will be captured.

3. Capture a Portion of the Desktop - Using a crosshair you can rubberband an area of the desktop to 
capture. When you release the mouse the area inside the rubberband is captured.

Once you have captured any portion of the desktop, the image will be displayed in TechFact's display 
window and has AUTOMATICALLY been placed in the clipboard.

You can use the "Print" button to print the image or simply paste the image to another application.



Saving CMOS Settings
You can save your current CMOS settings to a disk file. This file can then be used at a later time to 
restore CMOS in case it gets corrupted.

You will be asked to select a file path and name to which CMOS will be saved.



Restoring CMOS
You can restore a previously saved CMOS file so that it's settings overwrite what is currently in CMOS.

You will be asked to select a disk file to restore from. TechFacts has embedded special code in it's CMOS 
file format to prevent non-CMOS type files from being restored into CMOS. You will be warned if you 
attempt to restore an incorrect file type.



TechFacts Tools
The Tools tab provides you with options to watch changes on your system and evaluate Disk utilization.

When you click on the Tools tab you will be shown several buttons. To select a tool click on the specific 
button.

Program resources such as printing, refresh & clipboard are available for the Tools functions once data is 
displayed.

Data in this window is displayed in sortable\sizeable columns. You can sort the data by clicking on any 
column header and you can size any column by dragging on the column separation line.

Watching your System
Disk Utilization
Program Versions
Move It! File Reference Relocater



Watching Your System
Many users find that programs they installing or running tend to affect their systems in ways that can not 
be controlled or documented. This option allows you to invoke a measure to determine if any changes 
have been made to INI files, the Registry or any files on local or network disks.

There are 2 modes of operation:

1. You can specify a program to run - TechFacts will take a snapshot of your system, run the program you 
specify and then take a new snapshot. A comparison will be made between snapshots and a report will be 
generated.

2. You can monitor ALL activity on your system. This may be useful if you are trying to determine whether 
your system is being accessed without your knowledge.    Once again, 'before' and 'after' snapshots are 
compared for differences.

Follow these steps to invoke this powerful tool:

1. Determine whether you want to watch 'All Programs' or enter the name (or use the Browser) of the 
program you wish to run. This can be installation programs, ie:    A:SETUP or B:INSTALL.

2. If you want to watch for changes to the registry then ensure the checkbox contains a checkmark.

3. If you want to watch for changes to specific INI files then ensure the checkbox contains a checkmark.    
TechFacts by default watches WIN.INI and SYSTEM.INI, you can add or delete from the list using the 
'Add' or 'Delete' buttons.

4. If you want to watch for changes to local or network disks ensure the checkbox contains a checkmark. 

You can select which disks to watch by clicking on the disk names in the list box. Each click will toggle 
between 'Yes', 'No' or provide a drill-down list so you can watch specific directories only within a disk.

When you have made all of your selections click on the 'Go' button. TechFacts will now make a snapshot 
of your system. This could take several minutes as it is recording values in your registry and disk. The 
status of the snapshot is shown on the status bar.

During the 'snapshot' phase, you can use the 'Abort' button to cancel this activity. If you do so, your 
system will NOT BE under watch.

Once the snapshot is complete, the abort button will display 'End Watch'. This button when clicked will 
end the watching activity.

Once the watch is ended, TechFacts will once again take a snapshot of your system. Again this could take 
several minutes. When complete, a 'comparison' phase will begin and finally the results of the comparison 
will be displayed to you.



Disk Utilization
This feature provides you with a tool to determine how much disk space directories or files are using on your system.

You are asked to choose between 'Slack' usage - indicating the amount of space the File system actually is forced to allocate for a file or directory 
and 'Actual' usage which is the number of bytes of information the file has.

To start, select the local or network drive to scan and then click on the 'Scan Disk' button. TechFacts will then begin a detailed scan of all 
directories and files. This may take several minutes.

When the scan is complete you will be shown a list of directories and files at the 'Root' level of the drive you selected:

Dir/FIle Name - The subdirectory or File within this parent directory.

Size in Bytes - the number of 'slack' or 'actual' bytes for this subdirectory or file.    Note that for subdirectories the number of bytes includes all 
additional subdirectories and files within that particular subdirectory.

Pcnt of Parent - This is the percentage of space of the parent directory. In the case of viewing a root directory this would be the percentage of 
space on the actual disk.

You can drill down into subdirectories by double-clicking on them in the list and using the 'Go To Parent' button.

The list can be sorted by clicking on the column headers.



Program Versions
This tool examines all the programs on your system looking for specific version information that can be compiled into programs using resource 
headers.

The types of files that will be examined are: Executables (exe), Modules (dll), Virtual device drivers (vxd) and device drivers (drv).    There is an 
option to only request executable files (exe) if so desired.

The other option will allow you to only show program files that contain version information, otherwise this function will list all files as listed 
above.

Once the search is complete you will be presented with the following data:

1. Program Name. The file name, either 8x3 or long file names.
2. Program Path. The full path of the file.
3. Operating System. The type of operating system(s) the program will run on.
4. Version. The compiled version number of the program.
5. Company. The name of the software company providing the program.

You can double click on the program name to receive full details from the version resource header, including trademark and manufacturer 
comments (if available).

The list can be sorted by clicking on the column headers.



Move It! File Reference Relocator
The Move It! function allows you to relocate file references to files or applications you have moved on your disk or onto other local or network 
drives.

To use Move It! first physically move your application:    Files, Folders, subdirectories, etc.

Once complete use Move It! to change all references in INI files, the Registry, Program Groups and Shortcuts to point to the new location of the 
files\application. Follow these steps:

1. Enter the File\Folder name to change. This must be a fully qualified file or directory name.    Note: the "Start" button will remain disabled until 
the file\folder name you enter here is valid.

2. Enter the File\Folder name to replace it with. Once again, fully qualified and it must exist.

3. Select whether to scan: Ini Files, Registry, Program Groups or shortcuts. Check the checkboxes that apply.

4. Click on the start button.

5. The search may take several minutes. As matching files are found they are added to the list.

6. You may abort the search at any time by clicking on the "Abort" button on the toolbar. You will retain the search results already gathered.

7. At the end of the search you    can sort the list by clicking on the column headers.

8. To start the replacement process click on the "Replace" button. Click on the "Abort" button to cancel now without replacing any data.

9. When the replacement runs, each file will have the original file\folder replaced with the new one you entered.    At the end of the replacement 
process a report will appear detailing every change, update or failure that occured during the replacement process.



The Tweak Tab
The options under this tab allow you to view and modify your UI settings. The options are similar to other tweak programs but provide more 
choices and allow you to view the overall UI configuration before changing it.

The Tweak Form is divided into tabs that contain specific settings as well as a view of the entire UI settings available to you.

You can use the provided buttons to "Committ" changes you have made to the registry, or "ReRead" the settings from the registry.    Note that 
once you have committed changes to the registry, they are permanent until you reset them.    Some changes will not be visible to you until you 
restart Windows.

The only exception to the rule are the settings on the MSDOS tab. These settings directly affect how Windows will run on reboot and they do not 
get changed when you click on Committ. Click on "Next" for information on modifying MSDOS settings.



Modifying MSDOS settings
The MSDOS.SYS file is located in the root directory of your system and is hidden from you viewing or modifying it.

TechFacts 98 has provided a tab under "Tweak" functions that let you view and modify these settings.

WORD OF CAUTION: Modify these settings only if you understand the implications of doing so. We do not intend to explain these settings 
here, you need to either find documentation or talk to an expert about them!

When you have made your setting changes, click on the "Save" button. After confirmation, the new values will be written to the MSDOS.SYS 
file.

For backout purposes, before we update MSDOS.SYS we copy the current values to a new file MSDOS.001. If you have to recover, copy this file 
back to MSDOS.SYS and set the System and Hidden attributes on it to TRUE.



Logging Resources & Performance
You can use TechFacts 98 as a tool to log your system's resource and performance data. This is useful in trying to determine why a system's 
behaviour or resource usage is problematic.

In order to enable logging you must set the parameters found on the Logging Options form which is invoked from the "Action" Menu.



TechFacts Search Functions
The Search tab provides you with several different activities which can be used to search for DLLs, Files or Duplicate files.

When you click on the Search tab you will be shown several buttons. To select a search click on the specific button.

Program resources such as printing, refresh & clipboard are available once files are listed after a search is complete.

When a search is started an "ABORT" button appears in the speedbar near the top of the form. Clicking on the "Abort" button will stop any 
search in process and will display the partial results of the search (if any).



Searching for DLLs
The DLL search is used to display DLLs (modules) that are loaded, referenced, unreferenced and duplicated on your local or network drive.

When invoked you will be presented with a drive & directory selection window. Use this window to indicate the first level of your search for 
DLLs. All subdirectories will be searched.    To select a starting directory Double-Click on the directory name in the list, it will then appear at the 
top of the window. When done, click on "Ok".

The system will then search for all references to DLLs on your system, this could take several minutes, progress is shown on the bottom status 
line. To cancel the search, click on the "Abort" button in the speedbar.

Dlls will be presented in 5 seperate viewing areas:

DLLs Loaded - These modules are already loaded on your system.

DLLs Referenced - These modules were referenced by a Program or Module found on your search path.

DLLs Unreferenced - These modules were NOT referenced by any Program or Module found on your search path.

Files Referenced - The search found these Programs or Modules referenced other DLLs on your system.

Duplicate DLLs - These files were found more than once during the search.

There is a 6th viewing area located near the bottom of the DLL window. This area is a dynamic refernce area. If you click on a DLL or File found 
in other windows, then reference information is placed in this window.

You can use the "Delete Duplicates" button to remove any files that appear in the Duplicate files area.    The Clear button on the button bar can be 
used to clear all 6 viewing areas.



File Search
The File search provides a means of locating files on your local or network drive.

The following selection criteria are available:

Find - select the types of files to search for using standard wildcard representation such as "*.exe" or "abc*.*".
Where - Select the type of date to compare file date against, either creation, last write or last access.
Is - Is the date "All Dates" or "> < or =" a date you will select.
Get Date - use this button to view a calendar to select the date you are comparing against.
File Size Is - How will the size be compared? All file sizes or "> < or =" to a size you specify.
Bytes - Specify the file size to compare against in bytes.

Using the Drive & Path selection box select a drive or directory that will be your first directory to search. All subdirectories of this initial 
directory will be searched as well.

Click on the "Start Search" button to begin your search. The search can be aborted at any time by clicking on the "Abort" button on the speedbar.

When the search is complete the file list will be loaded with all files that match the search criteria. The following information is shown for each 
file:

File Name
File Path
Last Write Date
Size
Creation Date
Last Access Date

You can click on the column header for any of these items in order to sort the list of duplicate files by that column.

The following functions are available from the TechFacts speedbar or menu:

Clear - Clears the current file list
Print - Prints a list of all files in the list
Save - Saves the list of files to disk



Duplicate File Search
The Duplicate file search provides a means of locating duplicate files on your local or network drive.

Using the Drive & Path selection box select a drive or directory that will be your first directory to search. All subdirectories of this initial 
directory will be searched as well.

Click on the "Start Search" button to begin your search. The search can be aborted at any time by clicking on the "Abort" button on the speedbar.

When the search is complete the file list will be loaded with all duplicate files. The following information is shown for each file:

File Name
File Path
Last Write Date
Size
Creation Date
Last Access Date

You can click on the column header for any of these items in order to sort the list of duplicate files by that column.

The following functions are available from the TechFacts speedbar or menu:

Clear - Clears the current file list
Print - Prints a list of all duplicate files
Save - Saves the list of duplicate files to disk



Icon Search
This function searches all files on your system for icons.    Icons are compiled into programs however they are usually undocumented. This 
function lets you enumerate them and determine which icons come from which specific file.

Select the drive you wish to search. You may also drill down to the directory or subdirectory level by double-clicking on a drive or directory 
name.    The starting directory for the search is shown above the drive selection panel.

After you start the search it can be aborted at any time by clicking on the "Abort" button in the button bar. All icons found to this point will be 
displayed.

Note that during the search it takes time to update the display with icons found, so keep the viewing area as small as possible and let the icons be 
drawn in memory for speed!

When the search is complete you can click on any icon to see the file name and offset of the icon in the status bar.

You can use the "Remove Marked Icons" button to remove icons from the list in order to trim down the icons you don't want to see.



String Search
The string search lets you look for any size string across all files on your local or remote drives.    This function gives you several search options 
which can be used independantly or together:

1. Search Inside files. This is the traditional string search. Each file on your disk will be searched for the string, including non-Text type files.    
You are shown the File name, path and offset within the file.

2. Search File names. All long and short file names are scanned for the string.    You are shown the File name, path, date and size of the file.

3. Search INI files.    All INI files are scanned for the string. You are shown the section and the key of the matching line.

4. Search the Registry.    Search for the key within registry data. You are shown the Key, the Keypath and the related data containing the string.

5. Search Shortcuts and .LNK files.    The reference to the string within the shortcut file is displayed.

6. Search Program Groups.    The reference to the string within the program group file is displayed.

Search Options:

- Enter the search string. It is not case sensitive.

- Enter the file search mask. Use traditional search criteria:    *.*    *.exe abc*.*    etc..

- Select the type of search as explained above.

- Determine the starting drive or directory using the drive tree.

When your selection criteria are set, click on the "Start Search" button.    During the searches, the progress is shown on the status line.

You may abort the search at any time by clicking on the "Abort" button on the toolbar.    Search results gathered to this point are retained.



Zip\Lzh File Search
The Zip\Lzh search tool allows you to scan your local or remote drives for files that may be located within compressed libraries of the zip \ lzh 
formats.

To invoke this function:

1. Enter a file mask for the file(s) to be located WITHIN the compressed libraries.The default is *.*, however you can specify wildcards such as 
readme.* or *.exe.

2. Choose the Drive and\or directory to search by using the provided navigator. The drive\directory you will search appears directly above the 
navigator.

3. Click on "Start Search" to begin.    The "Abort" button will appear in the toolbar and can be used to abort a search at any time and provide you 
with results-to-date.

The Detailed file data is as follows:

File Name. The file name within the compressed file.
Compressed Size. The size of the compressed file in bytes.
UnCompressed Size. The size of the compressed file when uncompressed in bytes.
Date. The filedate of the compressed file
Library. The Path and filename of the compressed library from which this file was listed.

You can sort the data by clicking on the column header for each column.

You can print, save, copy to clipboard or email the data by using the tools on the toolbar.



The Network Tab
The options on this tab let you examine the performance and availability of network resources.

Since not all users have networks or access the internet, these options will disable themselves if the needed Windows 95/98 DLLs are not loaded 
by the operating system.

Available network functions:

Ping
Echo
Trace
List Network Resources

Required DLLs:    ICMP.DLL    WINSOCK.DLL or WSOCK32.DLL



The Ping Function
The Ping function is used to check for the availability (connectivity) of a given network resource.

You can use this function to check for Servers, Clients, Internet URLs, IP addresses and other IP based entities.

Enter the IP address or Host Name in the entry field and click on the "Ping" button.

The diagnostic list will detail the steps taken and the replies received from the requested resource.

You can print, copy to clipboard or save the results to a disk file.



The Trace Function
The Trace function allows you to view the route that the network took to get to the destination ip address or host name that you specify.

You can use this tool to help optimize network routing or indicate where network traffic exists or is being delayed.

Enter the IP address or Host Name in the entry field and click on the "Trace" button.

The diagnostic list will detail the steps taken and the replies received from the requested resource as well as the names and ip addresses of each 
network resource that was used on the way to the destination.

You can print, copy to clipboard or save the results to a disk file.

If you find that the trace is taking too much time or has reached an impass, click on the "Cancel" button.



The Echo Function
The Echo function allows you to send a message to the Echo port on a network resource which in turn will process the message and return it to 
you.

You can use this tool to help diagnose network traffic and timing issues as well as a better indicator of whether a network resource is available.

Enter the IP address or Host Name in the entry field and then either use the default message we provide or enter your own message.

You can also specify the echo port, the interval between echo attempts as well as the number of attempts within an echo session.

Click on the "Echo" button to begin the echo session.

The diagnostic list will detail the steps taken and the replies received from the requested resource.

You can print, copy to clipboard or save the results to a disk file.

If you find that the echo is taking too much time or has reached an impass, click on the "Stop" button.



Listing Network Resources
This option provides you with a means of listing network resources as seen from the "Windows" layer of the network protocols you may have 
loaded.

You can list:

- Current connections. These are the devices to which you are currently connected.
- Available resources. These are the highest layer of resources available to you on the network, usually network containers such as Netware or 
Banyan.
- Remembered connections. These are the devices to which Windows will automatically reconnect when Windows networking is started.

You can print, copy to clipboard or save the information listed.



Sending Internet Email
Any TechFacts 98 data can be transmitted to any internet email address using the embedded SMTP internet email module.    Requirements: An 
SMTP mailserver account via your internet provider or proxy.    If you can send email via Netscape Navigator or Internet Explorer then you can 
use this feature.

Once you have displayed data in any of the TechFacts tabs except "Action" then you can either choose the "Send Internet Email" option under the 
"Action" menu or use the Internet Email button on the speedbar.

You will be given an email form with a default recipient (if applicable) already filled in and the data from TechFacts as the body of the message.

You can add attachments, change the recipient or subject or modify the body of the text. When ready, click on the "Send" button to send the 
message.



Sending MAPI Email

Any TechFacts 98 data can be transmitted to any MAPI enabled network email address using the 
embedded MAPI email module.    Requirements: MAPI email such as that included in Windows for 
Workgroups or Windows 95/98 as well as a mailbox.

Once you have displayed data in any of the TechFacts tabs except "Action" then you can either choose 
the "Send MAPI Email" option under the "Action" menu or use the MAPI Email button on the speedbar.

You will be given an email form with a default recipient (if applicable) already filled in and the data from 
TechFacts as the body of the message.

You can add attachments, change the recipient or subject or modify the body of the text. When ready, 
click on the "Send" button to send the message.



Using the Detail Form
The detail form is invoked when you Double-click on specific TechFacts information.

This includes:
1. Any of the "Spy" tab options.
2. Any other option that provides a list of files.

When viewing files you can switch between ascii and hex mode by clicking on the "Key" image in the 
speedbar.    Hex mode is not available for "Spy" details.

You do not need to close the detail form each time it is used since the next invokation will cause the 
current copy to close before reissuing it.

The detail form can transmit the data in it's data panel via the MAPI and SMTP email facilities, if invoked 
and available.



Saving and Loading Configuration to a File
You can export your TechFacts 98 configuration from the registry to an INI style file by using the "Save Config To a File" option under the "File" 
menu.

This will allow you to customize a configuration which can be used as an import file to other users running TechFacts 98 or as a backup to your 
TechFacts registry configuration.

You can set your TechFacts 98 configuration by importing it from an INI style file containing valid configuration values.    Use the "Load" config 
from a File" option under the "File" menu.

You can also use the pre-load function from the command line to load values from a file.    The File may be local or remote and may contain any 
or all configuration values.



Viewing Configuration Data
This option allows you to easily view and search key configuration files on your system:

Autoexec.bat
Config.sys
Win.ini
System.ini
TechFacts 98 log. The file where the TechFacts 98 log is written to.
Alarm log. When TechFacts 98 memory\resource alarms trigger they can have an entry made to this log.
2 user selectable files.    These can be any text file such as batch or ini. Browse buttons can be used to 
search local or network drives.

When any file is chosen it is concatenated onto the edit form, ie: Config.sys would follow the last line of 
the Autoexec.bat. The edit form is refreshed each time a file is added or removed by clicking on its 
checkbox next to the name.

You can edit or add additional text into the edit form before printing, saving or copying to clipboard.

This option provides an easy means to capture and send configuration information to technical support.



Glossary of Terms
Atom - A string allocated by Windows which can be accessed globally.

DLL - "Dynamic Link Library" This is a non-program module which is loaded by a program. Contains forms, resources and functions.

Heap - An area of memory dynamically allocated by Windows or a windows program. Heap is allocated in blocks and resides above the 640k 
memory mark.

Module - see "DLL".

Process - This is a program, application or function that is running under windows. Similar to "Tasks" under Windows 3.1x but more powerful.

Thread - An allocation of CPU usage. Each thread may contain 1 or more programs. Threads determine the priority of CPU allocation a program 
receives.

Window - A visible or non-visible area on the screen that is owned and modified by a program.



Using TechFacts as a Technical Support Tool
TechFacts provides a powerful means to identify problems and resolve issues related to Windows 95/98 and the programs it is running.

Information that is gathered by TechFacts can be printed, saved to file, copied to the clipboard and transmitted to other people using any of 3 
powerful integrated tools:

1. MAPI Email - You can send data to other users on your same network using MAPI compliant email. The TechFacts data is sent as an email 
attachment to the recipient.

2. Internet Email - You can send data to other users via the internet.



Known Problems and Bugs
1. The CPU monitor may show 100% for some systems. This is a result of the call we are making being blocked with some CPU configurations. 
we are working on it for an upcoming release.



Keyboard Monitor

The Keyboard Monitor allows you to trace keyboard activity on your system.    Keyboard activity can be 
traced on 16 and 32 bit applications running under Windows 98 except for MS-DOS command shells.

The following data is presented on the trace. Clicking on the column header will resort the data on that 
column:

· Trace Time.
· Trace Data.

From the Keyboard Trace screen you have the following actions:

· Start Monitor. Implements the Keyboard hook and starts monitoring.
· Stop Monitor. Removes the hook and stops monitoring.
· Clear the Trace. Clears the current data visible in the trace.
· Options. Invokes the Keyboard Monitor options screen.



Keyboard Monitor Options

The screen lets you set the keyboard monitoring options for the next keyboard monitoring session. 
Options are saved in the TechFacts 98 registry key.

Trace frequency options:

· Character per trace line. Each key press creates a new trace line.
· Word per trace line. Each time the <Space> or <Enter> key is pressed a new trace line is created.
· Trace line seperated by Return. Each time the <Enter> key is pressed a new trace line is created.



CPU Information

The CPU Information screen provides detailed information on the CPU installed in your system.

You may also send this information via MAPI Email or Internet Email.



Using the Internet with TechFacts 98

TechFacts 98 has integrated web browsing using the Microsoft (tm) Internet Explorer engine that is 
provided on your Windows 98 system.    You do not necessarily have to use Internet Explorer (tm) in order 
to use TechFacts 98's web browing capability however you must establish an IP connection to a service 
provider.

There are 2 web browing modes provided on this Tab:



Version History
v2.10 11/7/98
 1. Addition of Internet Web Browser.
 2. Addition of Keyboard Monitor.
 3. Addition of CPU features.

v2.00 8/25/98
 1. Upgrade to support Windows 98 from v1.41 TechFacts 95.
 2. Removal of FAX capabilities.
 3. Misc. Bug fixes and modifications

v1.41 2/10/98
 1. Replaced all ghosted\browned out bitmap buttons with standard flyover buttons.
 2. Corrected problem with embedded help not working.



Registration Information
TechFacts 98 Registration Fee: $19.99 + shipping and handling (see table below)

Registration options:

1. Use your visa\mc\amex on the QWERKS secure online registration site. Use your browser to go to: 
www.qwerks.com or use the links on our home page.

2. Call Toll Free (u.s. only) 1-888-AT-ALTUS (1-888-282-5887) Mon-Sat 9:00 am - 10:00 pm (mst).

3. Canada, Mexico & International call 1-801-523-8221

4. U.S. and International FAX: 1-801-576-5663 (use the Fax & Email order form)

5. Email ordering: send an email to Sales@inquo.net (use the Fax & Email order form)

6. You can register online with Compuserve (members only). Use GO SWREG.

7. You may also send a cheque for $19.99 + shipping & handling to Dean Software Design    P.O. Box 
13032    Mill Creek, WA 98082-1032

Shipping & Handling Charges:
U.S.: $1.00
Canada & Mexico: $2.00
Europe, Asia, other: $3.00
Overnight U.S. only: $12.00

You must provide the information on the order form for Fax, Email and Postal registrations.

View and Print the Surface Post Order Form
View and Print the Fax & Email Order Form



TechFacts 98 Order Form
To: Dean Software Design
            P.O. Box 13032
            Mill Creek, WA 98082-1032

From: __________________________________

                  __________________________________

                  __________________________________

Phone: (              ) _________________________

Email: _________________________________

I would like to order ________ copies of TechFacts 98 at $19.99 per copy

For every copy ordered, add the following shipping and handling fee: U.S. $1.00 per copy. Canada & 
Mexico: $1.50 per copy.    Europe & Asia: $2.00 per copy.

Total purchase amount: $________________

Payment: Enclosed Check or Money order for $____________________

My Visa ______ or MC ______ number is: _______________________ Expiry Date: ______________

Instead of mailing a diskette, I would like a key for version: __________ emailed to: 
____________________________



TechFacts 98 Fax & Email Order Form
Your Name:
Company Name:
Billing Address (address credit card bill is sent to):
      Street Address:
      City:
      State\Prov:
      Zipcode:
      Country:

Mailing address (if different than above):
      Street Address:
      City:
      State\Prov:
      Zipcode:
      Country:

Home Phone Number:
Work Phone Number:
E-Mail Address:

Credit Card Information
      Type (visa\mc\amex):
      Account Number:
      Expiration Date:

Software To Order
      Title:
      Quantity:
      Total Software Amount:
      Total Shipping & handling amount:

      Total Order Amount:

      I would like a registration key sent to me (y/n):

If Faxed or e-mailed, please include the following language (and sign if Faxed):

I authorize INQUO(TM) Internet to bill my credit card and agree to pay the total amount according to card 
issuer agreement.

___________________________                        __________________
Signature                                                                                                      Date




